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Before Getting Started

TNTsim3D FREE isafree, standaloneversion of TNTsim3D ™ for Windows. It
provides you with the ultimate way to explore your geospatial data: real-time,
interactive, 3D viewing. Useyour joystick, keyboard, or mouseto moveover and
around asimulated 3D landscape and view georeferenced spatial data from any
vantage point. TNTsim3D FREE usesfiles prepared with the Landscape Builder
process in TNTmips®. Each landscape file contains a texture raster object pre-
cisely matched to aterrain raster; the texture raster layer can include any visual
combination of geospatial data.

Prerequisite Skills TNTsim3D FREE is easy to use even if you have no previous
experience with geospatial analysis software. |f you have used aflight simulator
software program and have ajoystick, you are already familiar with moving through
asimulated 3D scene. But even those without ajoystick can use the keyboard to
easily control movement, speed, and attitude.

Sample Data The exercises presented in this booklet use sample data distributed
with the TNT products. If you do not have accessto a TNT products CD, you
can download the data from Microlmages web site. In particular, this booklet
uses sample files BiGPINE.sIM and cRATERLK.SIM in the simpbaTA directory on the
TNT V6.6 products CD. You can also use any of the other landscape files on the
CD (or on Microlmagesweb site) with TNTsim3D FREE.

More Documentation This booklet is intended only as an introduction to the
featuresof TNTSIm3D FREE. A companion Tutorial Exercisesbooklet covering
the Landscape Builder in TNTmipsisin preparation.

TNTmips and TNTIite® TNTmips comes in two versions. the professional ver-
sion and the free TNTIite version. If you did not purchase the professional
version (which requires a software license key), TNTmips operatesin TNTIlite
mode, which limits object size and enables data sharing only with other copies of
TNTlite. TNTsim3D FREE isastandal one program that operatesindependently
of TNTmipsor TNTIite; it does not requirea TNTmips software license key.

Randall B. Smith, Ph.D.,22 January 2002
©Microlmages, Inc., 2002

It may be difficult to identify the important points in some illustrations without a
color copy of this booklet. You can print or read this booklet in color from
Microlmages’ Web site. The Web site is also your source for the newest Getting
Started booklets on other topics. You can download an installation guide, sample
data, and the latest version of TNTIite.

http://www.microimages.com
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Welcome to TNTsim3D FREE

Most geospatial datathat you work with isaselec-
tive representation of acomplex three-dimensional
landscape, but flat maps and images frequently con-
vey little sense of the vertical dimension. Contours
and relief shading can beincluded with the map data
for this purpose, but the ideal way to visualize the
true shape of your geospatial dataisto combinethe
data with an elevation model and “fly” over and
around a3D scene, examining featuresfrom any van-
tagepointinreal time.

TNTsim3D Free providesthis capability. It alows
you to move over 3D terrains using joystick, key-
board, or mouse controls. You can control all aspects
of the viewer orientation (attitude), height above
the surface, and speed. Special visua effects are
also available, such asautomatic texture smoothing
and atmospheric effects (fog / haze).

You create thedatafor the simulator using the Land-
scape Builder processin TNTmips, which createsa
terrain raster object and a texture raster object that
are specially optimized for real-timeinteractive 3D
rendering. Both of these objects are stored together
inalandscapefile, aspecialized type of TNT Project
Filewiththefileextension*.sim.

TNTsSm3D FREE issimilar in many respectstoflight
simulator software products. It usessimilar 3D ren-
dering principles and techniques and provides the
same real-time 3D movement. But the purpose of
flight simulator softwareisto mimic the experience
of flight, including different weather conditionsand
the flight characteristics of different types of air-
craft; the background landscape is secondary. The
purpose of TNTsim3D FREE, on the other hand, is
to allow you to view your geospatial dataasaland-
scape. Its emphasis is on alowing you to move
around and over the simulated landscapeinreal time
while maintaining the quality of the landscape ren-
dering.

¥ Download TNTsim3D

FREE to atemporary
directory on your
computer hard drive

M choose Run from the
Windows Start menu

M click [Browse] in the
Run window and
navigate to the
temporary directory

M select the file “Setup
TNTsim3DFree.exe” and
press [OK]

M follow the instructions in
the InstallShield wizard
to complete the
installation

M download (or copy from
the simpara folder on the
TNT V6.6 products CD)
files BiGPINE.SIM and
CRATERLK.SIM

The exercises on pages 4-5
cover hardware and
software requirements,
launching TNTsim3D FREE,
and loading data. Default
keyboard motion controls
and instructions for
configuring other input
devices are found on pages
6-10. Pages 11-12 cover
other input options and how
to adjust the tradeoff
between terrain quality and
frame rate. Texture
smoothing, fog, and other
special effects are
discussed on pages 13-15.
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Launching TNTsim3D FREE

A shortcut to the program is
created in the Microlmages
folder shown in the
Windows Start menu. You
can launch TNTsim3D FREE
from the Start menu, or
copy this shortcut to the
Windows desktop. You can
also double-click on any
TNTsim3D landscape file to
launch the program and
load the data from that file.

& Microlmages [-:]_[a] <]
File Edit Wiew ©So ”-
»

s, =

Back Farswarc!

Addrass ’m
== env]
o

TFRTT\ TNTsim3D
‘Products FREE
| BB |

2 object(s)

STEPS

M launch TNTsim3D FREE

M if a Select Graphics
System window opens,
select either DirectX or
OpenGL and click [OK]

M TNTsim3D FREE
Eile  View Help

Before running TNTsim3D FREE, make surethat ei-
ther OpenGL v1.1 or Microsoft DirectX 8.0 (or alater
version) is installed in your Windows system.
OpenGL isacross-platform program library for 3D
rendering and 3D hardware acceleration. Support
for OpenGL v1.1 isincluded with Windows98, NT
4.0, and later versions of the Windows operation sys-
tem. DirectX is a suite of Microsoft multimedia
program libraries that include Direct3D for 3D ren-
dering and hardware acceleration and Directlnput
for configuring motion controls for input devices
(such as keyboard and joystick). The TNTsim3D
page on the Microlmages web site provideslinksto
instructions on how to find what version of DirectX
isinstalled and how to download and install updates.

If only DirectX or only OpenGL isinstalled on your
computer, TNTsim3D will open directly using that
graphics system. |f both DirectX and OpenGL are
installed, before TNTsim3D opens you will be pre-
sented with a window asking you to select which
graphics system to use. In principle, DirectX and
OpenGL providesimilar capability and performance
in 3D rendering. Both systems can take advantage
of any 3D rendering capabilities built into your dis-
play board to accelerate performance, which means
higher frame rates and smoother movement. How-
ever, some display boards and
drivers may not provide equal sup-

= E3

Select Graphics System
@ {Directy
" DpenGL

W Always ask this o statup

¢ www.opengl.org

Ready

K | Exit

For information on and updates for the 3D
graphics libraries used by TNTsim3D, go to:

¢ www.microsoft.com/directx

port for DirectX and OpenGL, soone
may perform better than the other on
your computer. Youwill needto ex-
periment to determinewhich system
worksbest for you. For best perfor-
mance, make sure that you have the
most recent Windows-certified driver
for your video display board, and
follow the manufacturer’s instruc-
tionsto adjust hardware acceleration
settings.
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Loading a Landscape File

TNTsim3D opens by default with a single window
on your desktop. TheFileand View menus provide
access to most of the program controls. The File
menu is used to open alandscapefile and to exit the
program. This menu also shows the last four land-
scape files you have used, providing easy loading
of recently-used data.

When you open a landscape file, TNTsim3D reads
theterrainraster inthefileand constructsa3D model
of theterrain surface. The surface model isamesh of
interlocking 3D triangles that provides an efficient
approximation of the terrain surface. The texture
raster object isthen draped over this surface model.
To see the surface model alone,
choose View / Wireframe; thismenu

E™pigPine.sim - TNTsim3D FREE
File  wiew Help

STEPS

M choose Open from the
File menu

M navigate to the directory

into which you copied

the landscape files

(*.s1m)

select BIGPINE.SIM

choose Wireframe from

the View menu

repeat the previous step

to return to solid view

select Options from the

View menu and

examine the Display

panel, then click [OK]

H ® HA

option acts as a toggle between
solid and wireframe view modes.
The state you have set when you
exit the program is used by default
when you next open it.

solid view

You can resize the TNTsim3D win-
dow by dragging any edge or corner,
or use the standard Windows maxi-
mize/restore button ontheright side
of thewindow titlebar. Kegpinmind,

Ready

JS[=] B3

wireframe view

TN ¥

though, that increasing the window
sizeputsalarger demand on video memory and may
reduce the speed and smoothness of movement
through the ssmulation. In some instances your at-
tempt to enlargethe window may exceed theamount
of availablevideo memory. TNTsim3D inthat case
returnsto the previous window size and displaysan
error message explaining the problem. DirectX ap-
pears to be more demanding of video g
memory than OpenGL. If both graphics
systems are available on your computer,

Display I\nput | Tenain Y Eftects | Extias |

Graphics System

ade: 7385.00

Pitche0.00  Rolt0.00  Hee

You can switch between
DirectX and OpenGL on the
fly using the Graphics
System menu on the
Options / Display panel.

you can switch between them using the
Graphics System menu on the Display
panel of the Options window.

hardwaie acceleration. The software untime library ships with all

OpenGL iz a crozs-platform standard for 30 rendering and 30
windows, MacOS, Linus and Unix systems.
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First Flight: Using Keyboard Controls

STEPS

M choose Show Controls
from the View menu

M using the keyboard
motion controls shown,
experiment with moving
through the 3D scene

The normal view direction is
straight ahead in the
direction of flight. Use the
Look Right/Left/Up/Down
keys to temporarily look in
other directions.

¥ TNTsim3D Controls

Action | Keyboard | Jopstick. | Mouse

Although you may already have ajoystick or other
flight control deviceinstalled onyour computer, let's
usethekeyboard for your first flight, because anum-
ber of actions have been pre-assigned to specific
keys. Thesedefaultinput control settingsare shown
thefirst timethat you open the TNTsim3D Controls
window. You can keep this window open on your
desktop as a quick reference to the keyboard con-
trolswhile you try them out.

Thekeyboard controlsallow you to movein various
directions through the scene, control forward and
backward speed, and change your viewing orienta-
tion (attitude). The attitude controls use the same
motions that would apply to an aircraft: pitch, roll,
and turn. If you are not familiar with these terms,
pitch affectsthevertical angleinthedirection of
L | flight, roll affectstheangle of thewingsrelative

Altitude Up / Down

Slide Left / Right

Fonaard / Backward

Slide Up / Down

Pitch

Roll

Tum

Altitude Up A, Num +
Altitude Down Z. Enter
Slide Right F.Num3
Slide Left S, Num1
Forward Num &
Backward Murm 0
Thrattle Up
Thrattle Dowry
Throttle Zero
Slide Lip

Slide Down .
Fitch Up Up, Mum &
Fitch Down Down, Num 2

Z—Aoom

Fioll Right W, Hum 7
Fioll Left R, Hum 9
Roll Zera 3

Tumn Left Left, Num 4
Turn Right Right, Mum &
Look Right
Look Left
Lok Up
Look Down
Look Rear
Altitude Lock
Altitude Hat
Slide Hat
Lok Hat

rIz<m—

to the horizontal, and turn affects the heading
(the horizontal direction of flight).

The way in which you use a key on the key-
board depends upon which control is assigned
toit. Thegeneral motion controls (Altitude Up/
Down, Forward/Backward, Slide Right/L eft/Up/
Down, Pitch Up/Down, Roll Right/L eft, Turn Left/
Right) moveyou at a specified speed (discussed
later) aslong asthe key isheld down. To move
forward without having to continue holding a
key down, use the Throttle Up Key, which in-
creases your speed by afixed amount each time
itispressed. The Throttle Down key slowsyour
forward speed and, if you slow down to a stop,

Default input control
settings. If DirectX is
installed there are no
Num key assignments.

moves you backward at increasing speed. The
Throttle 0 key stops the motion begun by the other
Throttle keys, while Roll 0 levels the wings of the
virtual plane. The Look Right/Left/Up/Down keys
direct your view in a particular direction aslong as
they are held down. The Altitude Lock key acts as
an on/off toggle for maintaining the current altitude.
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Keeping Track of Where You Are

A simulation opens with a default viewer position
above the upper left corner of the scene, pointing
toward the scene center. Asyou fly around, infor-
mation on your viewing position isshown by default
in a Position Status bar at the bottom of the
TNTsim3D window. Thisbar showsyour horizontal
(x y) position (in map coordinates if the simulation
objects are georeferenced), altitude above sealevel
and height abovetheterrain surface (bothin meters),
and angles in degrees for pitch, roll, and heading.
You can use the mouse to drag and redock the Posi-
tion Status bar at the other edges of
the window or move it outside the
TNTsim3D window to form a sepa-
rate auxillary window. An optionon
the View menu aso allows you to
togglethe Position Statusbar on and
off.

In somessituations, especialy if you
areflying relatively fast, you may get
disoriented and lose track of where
you are and of your attitude. You

Elle  View Help

Ready

"M pigPine.sim - TNTsim3D

STEPS

M use the left mouse
button to drag the
Position Status bar
outside the TNTsim3D
window, forming a
separate window

M select Recenter from
the View menu

M select Restore Initial
Viewpoint from the
View menu

atus
P 83182.28  4112360.50
Altitude: 5711.34
Pitch: -18.73
Raoll: 1.13
Heading: 17112

Height Abave Surface: 436234

Mouse Position: 384960.38  4100445.00
Mouss Elevation: 142600

Frame Rate: 86.98

% Position: 383162.28 4112360.50 Altitude: 5711.34

AN

may find yourself pointing up to the
sky and not know where the terrain is, or fly right
through the terrain surface and end up underneath
it. The position status information can help you
figure out where you are. In thelatter case, for ex-
ample, the Height Above Surface parameter would
show anegative value. You could then use the Al-
titude Up control to move back above the surface.

If you can't get yourself reoriented manually, or
don’t want to bother, there are two short cuts avail-
ableonthe View menu.  You can use the Recenter
option to maintain your current position but reori-
ent the view toward the center of the scene. If thatis
not sufficient, you can choose Restore Initial View-
point, which jumps the viewer position and
orientation back to those of the starting point.

N
The Status Bar at the

bottom of the TNTsim3D
window shows the current
program status and also
acts as a tool tip when you
open a menu, providing a
description for the menu
option you have currently
highlighted.

View Hslp
v Status Bar
v Position Status Bar

Wireframe

Recenter
Restore Initial Wiswpoint

Options

Shaow or hide the controls panel
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Find Surface Coordinates with the Mouse

STEPS Aswe have seen, knowing your viewing positionin

B move the mouse Cursor | tha gmylationisimportant. But TNTsim3D enables
within the TNTsim3D . .
window youtoview georefe_ren(_:ed.spatlal data, so you may

M note how the Mouse be more interested in finding the map coordinates
Position and Mouse and surface elevation of particular locations on the
Efgﬁgﬁ"sgfﬂ?is'? the | |andscape surface. With TNTsSim3D you can use
update continuously the_ mouse to determine point coordinates for any
update visible portion of the scene.

When you place the mouse over some point on the
sceneinthe TNTsSm3D window, the program projects
a sight line from the viewer position through the
screen position of the cursor and on to the corre-
sponding position on the landscape surface. The
#¥BigPine.sim - TNTsim3D FREE horizontal (x y) map coordi-
File View Help nates of this position are
reported as the Mouse Posi-
tionitemin the Position Status
list. (If the landscape objects
are not georeferenced, theline
and column numbers of the
corresponding terrain raster
cell are shown.) The Mouse
Elevation entry showsthe cor-
responding surface elevation,
which isinterpolated from the
closest terrain raster cellsalong
the sight line. These coordi-
nate readouts are updated continuously as you

Pasition Status

Pusin 1311 226 41126050 move the mouse cursor over the scene. Deter-

ude: . . . ..

Fich: 1673 mining the positions of any number of scene
ol 1. . . .

Heading: 171.12 locations is quick and easy.

Height Above Surface: 4362 34

Mouse Position: 38896881 410328125
Mouze Elewatiors 120317

Frame Rate: 87.15
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Configuring Input Controls

TNTsim3D uses the Directlnput software compo- | STEPS .

nent of DirectX to allow you to configure theflight | @ Zg@cﬁhé \;'gr‘:‘é menu
controls for your keyboard or other i_nput devi.ce. & click on tf]e Input tab
You can reconfigure the controls while operating | & if you have a Configure

the simulator in either DirectX or OpenGL, but Directinput button at the
DirectX must be installed on your system in order E‘r’:sosmit"f the panel,
for you to do so. (OpenGL does not provide an | & click on the Keyboard

input configuration utility.) If you do not have tab and edit the
DirectX installed, therewill be no Directlnput push keyboard controls if you
button on the Optionswindow Input panel, andyou | gifkh[OK] o the

will be limited to using the default keyboard con- Directinput window and
trols. If so, thiswould be a good time to download the Options window
and install the latest version of DirectX from

Microsoft (see page 4).

¥ options
TheDirectlnput window hasatabbed panel  osiey et | Terain| Efects | £vtes |
for ajoystick or other game controller (if ~ seedtorbom [ 5 Fienspeed|  ©
oneisingtalled in your system), the key- ~ etavman [ = Aased [
board, and the mouse. The right side of Sr"MdF:j;tklid I
the keyboard panel lists the keys and the - mmean
currently assigned action for each. To ¢ ]
change the assignment for a key, click on
itsentry in the list or press the key on the
keyboard. Either action highlights the con- o] e
trol entry and shows a scrolling list of Directinput control window
available actions Keyboard [MOUSe |
in the lower |eft [T

3 Roll Zero W RollLeft &
. Choose an action for this E Throtde Up R Roll Right
portion of the T Slide Up Y Altitude Lock
. I Look Up A Altitude Up
panel TO wlvate S Slide Left D Throttle Zero
1 1 F Slide Right H Forward
the action lISt’ J Look Left K Look Down
press Enter (or L Look Right Z Aliitud...
. C Thrott... ¥ Slide Down
double-c“ck on N Backward M Look Rear
Available Actions Pitch Down Left Turn Left
the control entry) [rr—m— ight Turn Right Pitch Up

-

and select a new « Throtile Up —_—
v Throttle Down R

action from the « Throttle Zero -—-
scrolled list v Alitude Up -

v Altitude Down I

~ Slide Right Sort Assigned
v Slide Left g $

« Forward

~ Backward

 Slide: Un

page9



Configuring a Joystick

STEPS

If you have a joystick or

other game controller, make

sure that it is:

M plugged into your
computer

M set up and calibrated in
Microsoft Windows

Then proceed to

M press the Configure
Directinput button on the
Options window Input
panel

M select the tabbed panel
for your controller
configure the stick
(axis) controls and the
button controls

M close the Directinput
and Options windows
practice moving with the
joystick, supplemented
by keyboard controls as
needed

A joystick, yoke, or similar game controller gives
you moreredlisitic, intuitive control over your move-
mentsin TNTsim3D. Thelowest-cost joystickshave
only two rotation axes, so you must changeroll and
pitch (bank the plane) to maketurns. Higher-priced
(but still inexpensive) joysticks allow the stick to
twist, providing three axes of rotation and indepen-
dent control of turn, roll, and pitch. They also have
aseparate throttle control that can be operated with
your other hand, aswell asanumber of buttonsthat
can control other motions.

You can also use the mouse as a motion control, but
only inavery limited way. Themouseisbetter used
to interact with the datain the TNTsim3D window,
as described later.

TNTsim3D alows simultaneous use of different in-
put devices. So even if you have a joystick, you
may still want to use the keyboard to control some
actions. For example, if your joystick doesnot have
athrottle control, you can usethethrottle up, throttle
down, and throttle O controls on the keyboard to
control your speed.

Logitech WingMan Extreme Digital 3D | Keyboard m_

Information

he device. Press

n sion
Player

Available Actions
@ Button Actions
Throttle Up
« Throttle Down
“ Throttle Zero
v Alitude Up
v Altitude Down
- Slide Right
-~ Slide Left
-« Forward
- Backward

Slide Hat

Sample action

Look Down assignments that |
Look Rear have set for the 3-
axis joystick | use
at Microlmages. |
move the stick
forward or back to
change pitch, side
to side to roll, and
twist it to turn.
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Setting Other Input Options

The Input panel on the Options window also pro-
vides other settings that affect your movement
through the simulation. In the upper left part of the
panel are three linear speed settings: Up / Down,
Left / Right, and Forward / Backward. All areini-
tially set to the samevelacity (in meters per second),
which is based on the areal dimensions of the land-
scape. The default speed is computed to traverse
the maximum extent (height or width) of your land-
scape in 120 seconds. Each of these linear speed
values sets the speed used by the associated mo-

STEPS
M from the View menu

select Options

click on the Input tab
change the value in the
Speed Forward /
Backward field to 500
turn on the Minimum
Height check box and
change the height value
to 400

M click [OK] on the Options

window

M use any controls to

move closer to the
terrain surface until you
reach the minimum
height you have set

tion control. When you use the throttle controlsto
increment speed, the Speed Forward / Backward
value sets an upper velocity limit. You can change
any of these linear speeds to move more quickly.
But keep in mind that at faster speeds the

scene Changes rapl dly’ forCI ng TNTS m3D Display  Input |Terlain| Effects | Extras |
to read more data more quickly, and the  s.coup 0o [ 25 Pichspeet

imageinformation held in memory must be

—
Speed Left / Right 255 Roll Speed 45
updated morefrequently. Your movements =

Speed Forward / Backward 500 Tumn Speed

may becomeless smooth, and you may see F Miinun Heart 0
. . . K ki Helaht 00
moretransient rendering artifacts. S——

The settings in the upper right part of the
panel control the angular speeds (in de-
grees per second) for pitch, roll, and turn.
The default values are independent of the
landscape characteristics, and any
changes you make are retained for
usein later sessions. You can also
set both minimum and maximum
height values, which are also re-
tained until reset. Settingaminimum
height prevents you from flying
through and then under the terrain
surface. If you set the same value
for minimum and maximum height,
you can maintain a constant height
abovethe surfacewhileflyinginany
direction. = 7

oK Cancel

Flight following the ups and downs
of terrain at minimum height of 400 m.

EMBigPine.sim - TNTsim3™ FREE
File Miew Help
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Terrain Quality and Frame Rate

STEPS

M turn on the Wireframe
view mode (View /
Wireframe)

M select Options from the

View menu

click on the Terrain tab

increase the Quality

setting to 90 and click

[OK], and note the

increased detail in the

wireframe

M reset the Quality
percentage to 75

KRR

[#options |
Display | Input ~ Terain IEFIEE[SI Entras |
Vettical Exaggeration | 1.00.

& Quality ,W
" Fiame Rate [ 000

You can also set a Vertical

Exaggeration scaling factor
for the terrain model to vary
the vertical scale.

A new terrain model is built
for each frame using only

the visible part of the
terrain. The level of terrain
detail varies spatially in

each frame. More detail is shown
(by smaller terrain triangles) in the

foreground and in areas of

greater local relief. As you move
through the simulation, the amount
of detail for a particular area may

change, but height values are

automatically adjusted to produce
gradual rather than abrupt visual

changes in local detail.

Asyouuse TNTsim3D, you will likely want to move
through each landscape smoothly and realistically
and at the sametime see the maximum possible scene
detail. But achieving these twin goals may exceed
the resources available on your computer, so you
may need to choose which of them is more impor-
tant to you for a particular simulation session.

You can makethat choicein TNTsSim3D by using the
settings on the Options window’s Terrain panel,
whereapair of radio buttonsallow you to give pref-
erenceto either quality or framerate. Quality refers
to the amount of detail in the surface model created
fromtheterrain raster inthelandscapefile. Quality
is expressed numerically as a percentage; setting a
higher percentage produces a surface model that
showsmore of the detail intheterrainraster. Frame
rateisthe number of timesthe sceneisredrawn each
second. A higher frame rate produces smoother,
more natural movement through the landscape.

If you choosethe Qudlity preference, TNTSm3D uses
available resources to maintain your target terrain
quality and reduces the frame rate if necessary. If
you choose the Frame Rate preference, the program
instead attempts to maintain your target frame rate
and letstheterrain qual-
ity vary asneeded. The
effects of these selec-
tions depend greatly on
the hardware capabili-
ties of your computer;
they aremoresignificant
for newer, faster com-
puters and graphics
cards.

To

RRRAX

improve both quality and frame rate, try the following:

shut down other programs to free computer resources for TNTsim3D
make the TNTsim3D window smaller

make sure your graphics card’s 3D acceleration options are turned on
get a graphics card with faster 3D acceleration and more video memory
get more random access memory (RAM) for your computer
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Texture Smoothing

The Effects panel of the Options window lets you | STEPS _
control a number of visual effects for your simula- | @ tum off the Wireframe
. . . view mode (View /
tions, including background color, fog, and texture Wireframe)
smoothing. The Background Color control allows | & select Options from the
you to pick the background color from a standard View menu and click on
palette or define one or more custom colorsfor use | , l‘gﬁggi";sn ttf;
as backgrounds. Background Color color
L . sample button
The Smoot_h Text_ure option is avalaple only When ® use the resulting Color
you are using DirectX as the graphics rendering window to select a light
system for TNTsim3D. Smoothing has two major blue background color
advantages: it reducesthe blocky appearanceof fore- | ;r;ﬁec";;égtﬁ] Toxture
ground texture cells viewed at close range, and it checkbox on the Effects
reduces “sparkle” in the more distant portions of panel is active (not
the moving image. If you have a modern graphics dimmed), turn it on
board with 3D acceleration, the smoothing i B click OK on the Options
' g IS per- window
formed by the graphics |
i i
hardwareitself, sothereis = I Color HE
ml nl mal |mpaCt on frarne DlsD\ayl Input | Tenain Effects Extlasl B ol ‘

Backgiound Color [ ] | Imil | D mrr
rate. (If your board does  .oeco: R EEE
not support hardware e ========

. . ¥ LUse Background Calor
smoothing, the DirectX Fog Coler ———— EEEEEEEE
Software performs the € Lingar % Exponential € Exponential Two, EEEEEC .
smoothi ng though more Start [ 1000.00 End [ 2000000 Density 8.00
y Custom colors:

¥ Smoath Texture rrrrrrr

slowly). ottt el et
LI b Define Custom Calars »> |
Cancel

iews  Help

ine.sim - TNTsim3D FREE

.

unsmoothed smoothed

TNTsim3D window with new
background color and DirectX texture
smoothing enabled. Magnified views
of boxed area are shown above with
and without texture smoothing.
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Using Fog

STEPS

)

)

select Options from the
View menu and click on
the Effects tab

turn on the Fog check
box, accept the default
settings, and click [OK]

M note the change in

scene visibility

M reopen the Options

window Effects panel,
change the Start value
to 2000 and the End
value to 20000, then
click [OK]

M note the change in

scene visibility

M reopen the Options

Fog: Exponential Two

window Effects panel
and change the Fog
method to Exponential
Two

set the Density value to
7.0 and click [OK]

¥ Fog
W Use Background Color
FogColon [

& Linear ¢ Exponential { Exponential Twa

When you view anatural landscape, detail and color
become less distinct in more distant parts of the
scene because of the effects of water vapor and par-
ticulatesin the atmosphere. Haze is almost always
present to some extent, and fog is an extreme ex-
ample.

Toadd realismto alandscapein TNTsim3D, you can
simulate the reduction of visibility with distance by
using the Fog controls. The fog effect is achieved
by blending texture colors with varying amounts of
adesignated fog color. The background color isthe
default fog color, which lets the hazy or foggy ter-
rain blend naturally into the sky. For special effects
you can turn off the Use Background Color check
box and usethe Fog Color control to select any color
for the color blending.

Three methods are availableto control the variation
in fog density with increasing distance from the

viewer. Inthe Linear method, the Start value
 definesthe distance at which the fog effect
begins, the End value defines the distance
at which fog no longer increases, and the
variation is linear between these limits.
Since the start and end distances are in
meters, the same pair of
valueswill producediffer-
ing effects for landscapes

Start [ 400000 Eng | 4000000 e [ 7.00

¥ Fog
¥ Use Background Color
FogColer [ ]

" Linear © Exporential & Exporential Twa

of different areal extents.

Inthe Exponential method, fogincreases ex-
ponentially with distance. Inthe Exponentia
Two method, fog increases exponentially
with the square of the distance. In both
methods the Density parameter is a multi-
plier applied to the distance exponent.
Increasing the Density pa-
rameter makes the fog
thicken morerapidly with

Start [ 400000 Eng [ 4000000 Density 7.00

increasing distance.
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Using the Compass Graphic

The Extras panel on the Options window lets you
turn on arotating compass graphic that isshownin
thelower right corner of the simulation window. The
compass graphic can help you keep track of your
direction of view in three dimensions.

Thegraphic consists of acentral sphere, arrowsthat
point in the four cardinal directions (north, east,
south, and west), and arrows for the four intermedi-
ate directions (northwest and so on). The north
arrow, other cardinal arrows, and intermediatearrows
are shown in separate colors. (Color controls let
you change the arrow colors if you wish.) If the
landscape objects are georeferenced, the north ar-
row pointsin the north direction; otherwiseit points
parallel to the column direction in the rasters.

The compass points are drawn to lie in the horizon-

STEPS

M reopen the Options
window Effects panel,
turn off the Fog check
box, then click [OK]

M choose Open from the
File menu

M navigate to the directory

into which you copied

the landscape files

(*.sim) from the

TNTproducts 6.6 CD

select CRATERLK.SIM

choose Options from

NI

the View menu and click

on the Extras tab
M turn on the Show
Compass checkbox
M notice how the
compass rotates as you
move through the

tal plane, so the compass image provides a visual landscape
cue to your attItUde rd a[ive to the i'"cruierLk.sim - TNTsim3D FREE M[=E3

horizontal. Thisattitudeinformation

Fle  Wiew Help

is enhanced by shading effects on
the points and central sphere, which
areilluminated from above.

NatyColor -
rcinal Color | N
Other Color |

Enter a new Size value to change

the size of the compass graphic. Fieady

s
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Advanced Software for Geospatial Analysis

Microl mages; Inc. publishes a compl eteline of professional software for advanced geospatlal /

datavisualization, analysis, and publishing. Contact usor visit our web site for detailed prod-
uct information.

TNTmips TNTmipsisaprofessional system for fully integrated GIS, image analysis, CAD;

TIN, desktop cartography, and geospatial database management.

TNTedit  TNTedit provides interactive tools to create, georeference, and edit vector, image,

CAD, TIN, and relational database project materials in awide variety of formats.

TNTview TNTview has the same powerful display features as TNTmips and is perfect for
those who do not need the technical processing and preparation features of TNTmips.

TNTatlas TNTatlaslets you publish and distribute your spatial project materials on CD=,
ROM at low cost. TNTatlas CDs can be used on any popular computing platform.

TNTserver TNTserver lets you publish TNTatlases on the Internet or on your intranet.
Navigate through geodata atlases with your web browser and the TN Tclient Java applet.

TNTlite  TNTliteisafreeversion of TNTmips for students and professional s with small:-
projects. You can download TNTIite from Microlmages web site, or you can order
TNTlite on CD-ROM.

I ndex N
ﬁackground (o] Lo SOOI 13,14  Options window \
compass graphiC........ccceeeveererieresenieenens 15 Display pan€l........cccovveiiinincininns 5

DIr€Ct3D....uecveeeeeieecieeece e 4 Effects panel.... .
Directlnput...... .4,9,10 Extras panel.........ccoeoeienincnennnn 15

DirectX............ ...4,5,9 Input panel....... ..9-11
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